Installation and Configuration Guide for the ILM Store
Content

1 Introduction ............................................................... 5

2 Prerequisites ............................................................... 6
  2.1 Prerequisites for the Configuration ........................................ 6
  2.2 Prerequisite Components .................................................. 8
  2.3 Prerequisite SAP Notes .................................................. 9
  2.4 More Information .......................................................... 9

3 Configuration .............................................................. 11
  3.1 Authorizations ............................................................ 11
  3.2 File Handling ................................................................ 13
    Logical Files ................................................................. 13
    Commands for Using a File System ....................................... 15
  3.3 Business Application Log .................................................. 17
  3.4 Storage Connections ....................................................... 17
  3.5 Check Parameters of Internet Communication Manager ............. 20
  3.6 Origin ........................................................................... 20
    Concept .......................................................................... 20
    Customizing Values for SAP Origins ..................................... 22
    Use Origin per System ....................................................... 23
    Routing Table .................................................................. 23
  3.7 Set Up Client and Origins in the ILM Store ............................. 24
    Create Clients and Origins ................................................ 24
  3.8 Table Distribution ........................................................... 25
    Options for Table Distribution .......................................... 25

4 Publishing the ILM Store ................................................ 29
  4.1 Publish Storage System Using ICF Node ............................... 29
  4.2 Create Destination in the SRS System .................................. 29
  4.3 ArchiveLink Connection to the ILM Store .............................. 30
    Create ArchiveLink Connection .......................................... 33

5 Customizing ................................................................. 36
  5.1 Customizing the ILM Store ................................................ 36
    Customizing Settings Using View TILM_STOR_CUS .................. 36
    Making Customizing Settings with Transaction FILE ................ 40
    Overview: Namespaces and Properties .................................. 41
  5.2 Scenarios for Settings ..................................................... 42
Use Shared Files as a Transport Medium. .................................................. 42
Buffering PUT Request in a File. ................................................................. 42
Using the File System as a Store. ................................................................. 43
Use the External Job Control System. ......................................................... 43

6 Analysis Tools and Tests. ........................................................................ 44
6.1 Permitting Multiple User Agents. ............................................................ 44
6.2 Audit Table TILM_STOR_AUDIT. .............................................................. 44
6.3 Test Environment. .................................................................................. 44
  Origin for Test Purposes. ............................................................................. 45
  Acceptance Test. ......................................................................................... 45
  Delete Test Data. ......................................................................................... 46
  Performance Test. ......................................................................................... 46

7 Console. .................................................................................................... 49
Document History

⚠️ Caution
Before you start the implementation, make sure that you have the most current version of this document. You can find the current version here: SAP Information Lifecycle Management.

The following table contains an overview of the most important changes to the document.

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>2013-12-09</td>
<td>Initial Delivery</td>
</tr>
<tr>
<td>1.1</td>
<td>2014-02-15</td>
<td>Revised Version</td>
</tr>
<tr>
<td>2.0</td>
<td>2014-09-15</td>
<td>Enhanced Version</td>
</tr>
<tr>
<td>3.0</td>
<td>2015-06-15</td>
<td>Enhanced Version</td>
</tr>
<tr>
<td>4.0</td>
<td>2015-05-10</td>
<td>Enhanced Version</td>
</tr>
<tr>
<td>5.0</td>
<td>2015-10-11</td>
<td>Enhanced Version (NW 740 SPS 13 and NW 750 SPS 01)</td>
</tr>
<tr>
<td>6.0</td>
<td>2016-02-26</td>
<td>Enhanced Version (NW 740 SPS 14 and NW 750 SPS 02)</td>
</tr>
<tr>
<td>7.0</td>
<td>2016-09-21</td>
<td>Enhanced Version (NW 740 SPS 15 and NW 750 SPS 04)</td>
</tr>
<tr>
<td>7.1</td>
<td>2018-08-31</td>
<td>Enhanced Version</td>
</tr>
</tbody>
</table>
1 Introduction

With SAP’s ILM Store, you can run the entire data retention process - from archiving data to storing data - within the SAP environment without having to use external interfaces. The specifications from Retention Management for SAP Information Lifecycle Management (ILM) are taken into consideration during this process.

This means you can store archive files and indexes by using the WebDAV interface standard in a database (for example, SAP IQ or SAP HANA). How you do this is described in the specification BC-ILM 3.0 for ILM-compliant storage systems.

ILM Retention Management defines the interface BC-ILM 3.0 as an enhancement of the WebDAV protocol for storing and enhancing data. The SAP ILM Store enables you to map data archiving with ILM Retention Management, including the physical storage of data, as a process integrated in SAP without the need of third parties. This guide provides step-by-step instructions for configuring your ILM Store so that it is ready to use.
2 Prerequisites

2.1 Prerequisites for the Configuration

This installation and configuration guide requires the completed installation of the system landscape. You have installed all of the required software components and imported the required notes.

For more information about the prerequisite components and notes, see the chapter Prerequisite Components in this document as well as in the application documentation on SAP Help Portal at http://help.sap.com/nw. Choose SAP NetWeaver Platform ➔ Application Help ➔ Function-Oriented View ➔ Solution Life Cycle Management ➔ ILM Store ➔ Prerequisites for Using the ILM Store.

Seen schematically, you need the following components to be able to work with the ILM Store:

- Software modules that create archive files and store these by using SAP ILM Retention Management
- SAP ILM Retention Management (BC-ILM-IRM)
- Storage and Retention Service (BC-ILM-SRS)
- ILM Store (BC-ILM-STO)

With the ILM Store, you have a certified, SAP-specific store for BC-IM 3.0. The used interface BC-ILM 3.0 is an enhancement of the WebDAV protocol and you use it to store and adjust data. ILM Retention Management defines this interface. All store providers that use SAP ILM must implement the requirements from this interface. The SAP ILM store also implements this interface and is certified with Certification Suite for AS ABAP. For more information about the Certification Suite for AS ABAP, see the corresponding implementation guide at Certification Suite BC-ILM 3.0.

- Database Server (for example, SAP IQ or SAP HANA)
The following figure shows the largest possible distribution of the participating components:

Alternatively, you can randomly bundle the components that are identified in the figure with AS ABAP (Application Server for ABAP) so that the compact distribution shown in the next figure is also possible:

The components you actually need are described in the following chapter, Prerequisite Components.
2.2 Prerequisite Components

You have installed the following components:

- You have activated the ILM Database Store (ILM_STOR) business function. For more information about the business function, see SAP Help Portal at http://help.sap.com Enterprise Management > SAP ERP > Application Help > Choose Language > Business Functions > Business Functions in SAP NetWeaver > ILM Store. You need the business function to be able to work with the ILM Store.
- You have activated the Information Lifecycle Management business function (ILM). For more information about the business function, see SAP Help Portal at http://help.sap.com Enterprise Management > SAP ERP > Application Help > Choose Language > Business Functions > Business Functions in SAP NetWeaver > ILM. You need the business function to be able to work with SAP ILM Retention Management and the Storage Retention Service (SRS).
- Use one of the following databases:
  ○ Database of the Enterprise Edition of SAP IQ as of Version 15.4 SP03
    ○ For more information about the Enterprise Edition of SAP IQ, see SAP IQ Community.
    ○ For more information about the installation of the Enterprise Edition for SAP IQ and the required licenses, see SAP First Guidance - SAP NetWeaver BW: Implementation SAP NLS with SAP IQ.
  ○ SAP HANA Database, as of Version SPS06, Features included in Revision 60
    For more information, see SAP Help Portal at http://help.sap.com/hana_platform.
- If you want to use a file system instead of a database for your storage, there is one available for storing files.

**Note**

To do so, you have familiarized yourself with the ILM Store by performing the following actions:

- Mounting the drive
- Entering the drive in FILE
- Specifying the logical file name in Customizing (this means making the use of all directory names known; see the chapter Making Customizing Settings with TILM_STOR_CUS)

- You have installed the following components as of the version specified or higher:

<table>
<thead>
<tr>
<th>Type of Component</th>
<th>Component</th>
<th>Needed Only for the Following Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Component*</td>
<td>SAP_BASIS 740 Support Package Stack 13</td>
<td>ILM Store</td>
</tr>
<tr>
<td>Application Component</td>
<td>Retention Management for SAP Information Lifecycle Management (BC-ILM-IRS)</td>
<td>SAP ILM’s Retention Management establishes the connection between Archive Development Kit (ADK) and the ILM Store. The expected interface implements the specification BC-ILM 3.0.</td>
</tr>
</tbody>
</table>
**Type of Component** | **Component** | **Needed Only for the Following Function**  
--- | --- | ---  
Application Component | Storage and Retention Service (SRS) (BC-ILM-SRS) | ILM Store

*We recommend using the **highest available software component version** for the productive use of the ILM Store - however, at least SAP NetWeaver 7.40 SP13.

### 2.3 Prerequisite SAP Notes

Below you will find a list of SAP Notes that are required for the configuration of the ILM Store.

**Recommendation**

Note that the **recommended release** for productive use is SAP NetWeaver 7.40 SP13 or higher. The following notes are included in the support package as of release SAP NW 7.40 SP13 and are relevant only for lower SPs.

Also note that the full range of functions for the ILM Store is supported only as of 7.40 SP13.

<table>
<thead>
<tr>
<th>Note Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2563024</td>
<td>Collection of SAP Notes that are required for ILM Store.</td>
</tr>
</tbody>
</table>

### 2.4 More Information

**SICF Services for SAP ILM**

A service for ILM Store should be created and activated in transaction SICF. The ILM Store is to be published after configuration is complete (see the *Publish Storage System Using ICF Nodes* section).

**Note**

For more information about activating services in the Internet Communication Framework, see SAP NetWeaver Library under [http://help.sap.com/nw](http://help.sap.com/nw) ➔ **SAP NetWeaver Platform ➔ Application Help ➔ Function-Oriented View ➔ Application Server ➔ Application Server Infrastructure ➔ Functions and Tools of SAP NetWeaver Application Server ➔ Connectivity ➔ Components of SAP Communication Technology ➔ Communication Between ABAP and Non-ABAP Technologies ➔ Internet Communication Framework (ICF)**
**SAP IQ**

Note that you also need to ensure the following for the SAP IQ database:

1. The unstructured data analytics option (IQ_UDA) is available.
2. The variable `ENABLE_LOB_VARIABLES` is set to `ON` for the database.

**Storage and Retention Service (SRS)**

We recommend installing SRS locally for performance reasons. A remote installation is possible but it is slower.

1. To determine the SRS installation type, choose transaction `SARA`.
2. Then, in the SAP menu, choose `Goto` `Customizing` `Technical Settings` `ILM Store Service`.
3. Select `Local (Use Local ILM Service)`.

If you have clients with a release earlier than 7.31 SP10 and want them to connect to ILM Store, you can use SAP Note 1659904 for releases down to 7.02/7.01 SPS 08.
3 Configuration

3.1 Authorizations

To be able to set up and use the ILM Store, you need to assign the required authorizations to the relevant users.

Access to the ILM Store

1. You need a technical user with the necessary authorization to access the ILM Store and to save files to the store. You need to assign authorization object SILMSTOR with activity ACTVT = 16 (Execute) to the relevant role.
2. You then assign authorization object S_DATASET with the following values to this user so that the file system can be used to temporarily store the data:
   - File Name: *
   - Program: CL_ILM_STOR_DATASET CP and RILM_STOR_PUT_WORKER
   The following activities belong to the authorization object:
     - 06 = Delete
     - 33 = Read
     - 34 = Write
3. Assign authorization object S_DEVELOP with the following values to generate temporary tables:
   - OBJTYPE=TABLE
   - ACTVT=07 and 40
4. Assign authorization object S_CTS_ADJ with the following values to generate temporary tables:
   - CTS_ADMFCT=TABLE
5. Assign authorization object S_CTS_SADM with the following values to generate temporary tables:
   - CTS_ADMFCT=TABLE

For more information about using this authorization, see the chapter Publish Storage System Using ICF Nodes in this document.

ILM Store Administration

To be able to install, configure, and test the store, you need a role with administration authorization.

The authorization object SILMSTORAD with the following activities provides the authorizations required for this role:

1. 02 = Change
2. 07 = Activate, Generate
3. 39 = Check

You can also use activity ACTVT = 07, which belongs to the same authorization object, to provide the authorization for installing the ILM store.

**ILM Store Installation**

For the installation of the ILM Store, the administrator must specify the location where the data is to be stored. The administrator can perform this distribution only **once** after the installation. In SAP NetWeaver Customizing, choose Application Server > Basis Services > Information Lifecycle Management > ILM Store > Define Settings for Administrative Customizing.

⚠️ **Caution**

Changing the setting later on during operations can lead to the loss of all information stored up to that point in time.

For this reason, you need a separate authorization for the installation that is provided by authorization object SILMSTORAD with activity ACTVT = 07.

**Testing the ILM Store**

The **Origin** is a central element in the configuration of the store. You can use the test reports to check the configuration defined in the Origin.

The authorization object SILMSTORAD with activity ACTVT = 39 (Check) provides the administrator with the authorizations to make the settings needed for testing and to run the required tests.

⚠️ **Caution**

If you change the Origin settings during operations, you might lose all of the information you have stored up to now.


**Customizing the ILM Store**

After installation and setting up distribution, the administrator must make the Customizing settings in the ILM Store. The authorization object SILMSTORAD with activity ACTVT = 02 (Change) provides the authorization that is necessary to do so.

For more information about Customizing the ILM Store, see the section on **Customizing** in this document.
3.2 File Handling

3.2.1 Logical Files

The ILM Store can use temporary files in the following situations:

- Within a network, archive files are transferred in the form of shared files.
- To buffer data of a certain volume before writing it to the database.

File names must be verified in the AS ABAP to prevent a search of the entire directory. You use function module FILE_VALIDATE_NAME for this purpose. This requires a logical file name as well as a logical path.

The function module performs a check that determines whether the logical file exists, or is permitted to exist, in the logical path assigned to it. Therefore all specified paths within the ILM Store always consist of these two components. The ILM Store contains the following settings:

<table>
<thead>
<tr>
<th>Key terms</th>
<th>Value in transaction FILE</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADK_FILE</td>
<td>ILM_STOR_ADK_FILE</td>
</tr>
<tr>
<td>ADK_ROOT_FOLDER</td>
<td>ILM_STOR_ADK_ROOT_FOLDER</td>
</tr>
<tr>
<td>AN_FILE</td>
<td>ILM_STOR_AN_FILE</td>
</tr>
<tr>
<td>AN_ROOT_FOLDER</td>
<td>ILM_STOR_AN_ROOT_FOLDER</td>
</tr>
<tr>
<td>ILM_STOR_FILE</td>
<td>ILM_STOR_FILE</td>
</tr>
<tr>
<td>ILM_STOR_FOLDER</td>
<td>ILM_STOR_FOLDER</td>
</tr>
<tr>
<td>ILM_STOR_REQ_SHARED_FILE</td>
<td>ILM_STOR_REQ_SHARED_FILE</td>
</tr>
<tr>
<td>ILM_STOR_REQ_SHARED_FOLDER</td>
<td>ILM_STOR_REQ_SHARED_FOLDER</td>
</tr>
</tbody>
</table>

In transaction FILE, you can either adjust predefined values as needed or you can create your own paths or files. You can then enter these in Customizing instead of using the delivered values. The ILM_STOR_FILE and ILM_STOR_FOLDER should be defined as the temporary buffer and they are always needed.

**ADK_FILE and ADK_ROOT_FOLDER**

ADK_FILE as well as ADK_ROOT_FOLDER define the logical file name (path and file name) of ADK files if these are to be stored in the file system.
### Key

<table>
<thead>
<tr>
<th>Logical Path</th>
<th>Operating System</th>
<th>Physical Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADK_ROOT_FOLDER</td>
<td>ILM_STOR_ADK_ROOT_FOLDER</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;P=DIR_TEMP&gt;/&lt;FILENAME&gt;</td>
</tr>
</tbody>
</table>

#### Logical File: ILM_STOR_ADK_FILE
- Physical file: <space>
- Data format: DIR
- Applicat. Area: BC
- Logical Path: ILM_STOR_ADK_ROOT_FOLDER

### AN_FILE and AN_ROOT_FOLDER

Define the logical file name (path and file name) of anonymous files if these are to be stored in the file system. Anonymous files are those that are stored outside of the ILM context.

<table>
<thead>
<tr>
<th>Logical Path</th>
<th>Operating System</th>
<th>Physical Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>AN_ROOT_FOLDER</td>
<td>ILM_STOR_AN_ROOT_FOLDER</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;P=DIR_TEMP&gt;/&lt;FILENAME&gt;</td>
</tr>
</tbody>
</table>

#### Logical File: ILM_STOR_AN_FILE
- Physical file: <space>
- Data format: DIR
- Applicat. Area: BC
- Logical Path: ILM_STOR_AN_ROOT_FOLDER

### ILM_STOR_FILE and ILM_STOR_FOLDER

Define the logical file name (path and file name) of temporary files, for example, those used when buffering PUT requests.

<table>
<thead>
<tr>
<th>Logical Path</th>
<th>Operating System</th>
<th>Physical Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>ILM_STOR_FILE</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ILM_STOR_FOLDER</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Key</td>
<td>Logical Path</td>
<td>Operating System</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>ILM_STORE_FOLDER</td>
<td>ILM_STOR_FOLDER</td>
<td></td>
</tr>
<tr>
<td>ILM_STOR_REQ_SHARED_FOLDER</td>
<td>ILM_STOR_REQ_SHARED_FOLDER</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Key</th>
<th>Logical Path</th>
<th>Operating System</th>
<th>Physical Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>ILM_STORE_FOLDER</td>
<td>ILM_STOR_FOLDER</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ILM_STOR_REQ_SHARED_FOLDER</td>
<td>ILM_STOR_REQ_SHARED_FOLDER</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Logical File: ILM_STOR_FILE**
- Physical file: `<space>`
- Data format: DIR
- Applicat. Area: BC
- Logical Path: ILM_STOR_FOLDER

**ILM_STOR_REQ_SHARED_FILE and ILM_STOR_REQ_SHARED_FOLDER**

Define the logical file name (path and file name) in the situation where the ADK transports the PUT request data using a shared file instead of in the HTTP request. Normally, this is the logical file name under which the ADK files are stored (ARCHIVE_GLOBAL_PATH).

<table>
<thead>
<tr>
<th>Key</th>
<th>Logical Path</th>
<th>Operating System</th>
<th>Physical Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>ILM_STOR_REQ_SHARED_FOLDER</td>
<td>ILM_STOR_REQ_SHARED_FOLDER</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ILM_STOR_REQ_SHARED_FOLDER</td>
<td>ILM_STOR_REQ_SHARED_FOLDER</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Key</th>
<th>Logical Path</th>
<th>Operating System</th>
<th>Physical Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>ILM_STORE_FOLDER</td>
<td>ILM_STOR_FOLDER</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ILM_STOR_REQ_SHARED_FOLDER</td>
<td>ILM_STOR_REQ_SHARED_FOLDER</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Logical File: ILM_STOR_REQ_SHARED_FILE**
- Physical file: `<space>`
- Data format: DIR
- Applicat. Area: BC
- Logical Path: ILM_STOR_REQ_SHARED_FOLDER

### 3.2.2 Commands for Using a File System

If you use a file system instead of a database to store your data, you need the following commands for working with the file system:

- **ILM_STOR_DIR**: Used to read the content of a directory and check whether a file exists.
• **ILM_STOR_MKDIR**: Directories can be created.
• **ILM_STOR_DIR_FILES**: Check for files.

You can use the transaction *External Operating System Commands* (SM49) to execute these commands.

**Create a directory**

Command name: **ILM_STOR_MKDIR**

Operating system:

- WINDOWS NT: Operating system command: `cmd /C mkdir`
- UNIX: Operating system command: `ls`
  Parameters for operating system command: `<empty>`
- [x] Additional parameters allowed
- Check module: **FM_ILM_STOR_MKDIR_CHECK**

**Check directory**

Command name: **ILM_STOR_DIR**

Operating system:

- WINDOWS NT: Operating system command: `cmd /C dir`
  Parameters for operating system command: `/AD /L /B`
- UNIX: Operating system command: `ls`
  Parameters for operating system command: `-d`
- [x] Additional parameters allowed
- Check module: **FM_ILM_STOR_DIR_CHECK**

**Check files**

Command name: **ILM_STOR_DIR_FILES**

Operating system:

- WINDOWS NT: Operating system command: `cmd /C dir`
  Parameters for operating system command: `/AD /L /B`
- UNIX: Operating system command: `find`
  Parameters for operating system command: `<empty>`
- [x] Additional parameters allowed
- Check module: **FM_ILM_STOR_DIR_CHECK**

You can run the **RIILM_STOR_TEST_SM69** report to create these Z commands for the WINDOWS NT and UNIX operating systems only in NW740SP16 and NW750SP05 or higher systems.
3.3 Business Application Log

The standard SAP delivery includes the settings for the *Business Application Log*. You can verify these settings with transaction *Application Log: Object Maintenance* (SLG0).

The following objects are relevant:

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Object</th>
<th>Object Text / Subobject</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main Object</td>
<td>ILM_STOR</td>
<td>ILM Storage: Integrated DB Archive Store</td>
</tr>
<tr>
<td>Subobject</td>
<td>TECH</td>
<td>Additional Information for Analytical Purposes</td>
</tr>
<tr>
<td>Subobject</td>
<td>PROCESS</td>
<td>Process Information</td>
</tr>
</tbody>
</table>

3.4 Storage Connections

The ILM Store uses some management tables on the application server to save administration data. The data should be stored in a different place. You can store the data in the following storage media:

- Database Connections
- File system (external drives mounted via NFS for example)
- Hadoop

Database Connections

The ILM Store can store the archive file in database tables. These form a pool of tables which store the data as BLOBs (Binary Large OBjects).

You can store these tables on the application server or on external SAP HANA / SAP IQ databases. For more information, see the chapter on *Table Distribution* in this document.

You need to create secondary database connections depending on the distribution plan.

For more information about secondary databases, see the SAP ERP library at [http://help.sap.com/erp](http://help.sap.com/erp).
Use transaction the **Database Connection Maintenance** (**DBCO**) to create the required secondary database connections. If there are connections to SAP IQ, use the conditions for the following schema:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB Connection</td>
<td>Unique connection name, such as <strong>ILM_STOR_IQ_&lt;server name&gt;</strong></td>
</tr>
<tr>
<td>DBMS</td>
<td><strong>SYB</strong></td>
</tr>
<tr>
<td>SYB</td>
<td>User for Database</td>
</tr>
<tr>
<td>DB Password</td>
<td>*****</td>
</tr>
</tbody>
</table>

**Connection information**

- **SYBASE_SERVER** = Host address of the server on which IQ runs
- **SYBASE_PORT** = Port on which the database query waits, for example, 2700
- **SYBASE_IQ_ENGINE** = Name of the IQ installation
- **SYBASE_DBNAME** = Name of the database store
- **SYBASE_CONTYPE** = IQ
- **SYBASE_IQ_LOAD** = 1
- **SYBASE_IQ_CESU-8** = 1
- **SYBASE_IQ_LOAD_SIDE_FILES** = 1

**Permanent**

- `<space>`

**Connection Limit**

- **0**

**Optimum Connecton**

- **5**

**i Note**

If you want to set up an SSL-encrypted database connection to SAP IQ, see SAP Note **1820202**.

**Testing a Database Connection**

Start transaction **SE38** and run ABAP report **ADBC_TEST_CONNECTION** to test the configuration of the database connection.

**File System Connections**

You need custom connection types to define how ILM Store connects to the file system.

**Custom Connection Types**

A database used for storing the Archive Development Kit (ADK) content can be connected to the ILM Store through a data base connection using the transaction **DBCON**. The database connection is always connected to
the type of the database or the database type (DBSYS) value. You use the database type value to search in the
class factory (TILMSTOR_CF) for a matching interface IF_ILM_STOR_DB_OPERATOR and
IF_ILM_STOR_DB_INFO implementation that implements the physical access to the storage media. In the ILM
Store the key pair of DBCON/DBSYS points to the required IF_ILM_STOR_DB_OPERATOR|
IF_ILM_STOR_DB_INFO pair for accessing any storage media. The assignment for the ILM Store is as follows:

- DBCON is the connection ID
- DBSYS is the connection type
- Customizing for TILM_STOR_BLOB points to a Connection ID.
- The connection ID entry is used to determine the connection type value from the following:
  - DBCON
  - If it is not a DBCON entry, then from Customizing using the CONSYS.<connection.ID> value in
    namespace DB
- The connection type value, in turn, is used to determine the implementation in the class factory for
  interface implementations IF_ILM_STOR_DB_OPERATOR and IF_ILM_STOR_DB_INFO.

例

The file system implementation is used in test report RILM_STOR_TEST_FILE. Here you create two
Customizing entries and perform the following steps:

- You can create the connection type for the connection ID (and call it, SAP_CONN_DEF, for example) as
  CONSYS.SAP_CONN_DEF = SAP_SYS_FILE. This is the initial step.
- You can then set DBCON.TILM_STOR_BLOB pointing to the connection ID SAP_CONN_DEF defined
  above.
- You can create a new entry in the class factory, using interface as IF_ILM_STOR_DB_OPERATOR and
  parameter as SAP_SYS_FILE.

文件系统实现

在本例中，当你看到Customizing设置时，你可以推断连接ID是
SAP_CONN_DEF。然后你尝试通过读取DBCON来确定连接类型，但你没有得到

图
value. So you then use the key CONSYS.SAP_CONN_DEF and read Customizing. This returns the value of connection type as SAP_SYS_FILE. You can use the connection type to access the class factory, using the interface IF_ILM_STOR_DB_OPERATOR|IF_ILM_STOR_DB_INFO as the key and the connection type as the parameter.

Hadoop

You can use a Hadoop cluster to store your archive files. For more information, see the Hadoop Configuration guide. The customized connection types are also used to establish a connection between Hadoop and ILM Store.

3.5  Check Parameters of Internet Communication Manager

The resources are transferred in an HTTP request. To guarantee a smooth transfer, you must check the permitted request size in the parameters of the Internet Communication Manager (ICM).

1. To do so, call the ICM Monitor (transaction SMICM).
2. In the ICM Monitor menu, choose Goto Parameter Change.
3. Check the following parameters and adjust them if necessary:

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>icm/HTTP/client/keep_alive_timeout</td>
<td>Determines how long an HTTP connection stays open. Can improve performance, especially that of smaller resources, if the value is increased.</td>
</tr>
<tr>
<td>icm/HTTP/max_request_size_KB</td>
<td>Determines the maximum data size that the ICM will accept.</td>
</tr>
<tr>
<td></td>
<td>The value – 1 accepts all sizes. For example, a value of approximately 102400 (100 MB, the default value) rejects all requests that are larger.</td>
</tr>
<tr>
<td></td>
<td>Enter a value based on the largest possible size of a single archive file that can occur in your system.</td>
</tr>
</tbody>
</table>

3.6  Origin

3.6.1 Concept

The Origin serves as the identifier of the source of the data (data origin). All of the systems that want to use the ILM Store do this in the context of the origin (data origin).
With the help of Origins, you can treat the data from different sources differently. You can, for example, treat the data from Retention Warehouse differently than the data from a productive server group. You can, address another database system (or a completely different storage medium, such as tapes) as the memory. To achieve this, it is mandatory that you link each request to the store with the required origin.

→ Recommendation

We recommend that you familiarize yourself with the origin concept and its use in the ILM Store before you start configuring. For more information about origins in the ILM Store, see the application documentation on SAP Help Portal at http://help.sap.com/nw ➤ Select SAP NetWeaver Platform ➤ Application Help ➤ Function-Oriented View ➤ Choose Language ➤ Solution Life Cycle Management ➤ ILM Store ➤ Origin.

The origin to be used is transferred by including it in the request itself.

The origin is the central element in the store for separating various scenarios and clients from one another. This version provides the option of determining the origin in the respective client (BA pi implementation) and copying it to the ILM Store. The prerequisite for this is that SRS is installed locally. This means that you can, for example, send the archives for the business application log to Origin #1 (that is connected to the file system as a store) while FIN files are sent to Origin #2 (that is connected to the database).
3.6.2 Customizing Values for SAP Origins

SAP delivers special origins in advance that require you to make additional settings:

- As of release SAP NW 7.40 SP13, the origin sap must be set in more detail due to the security requirements for file handling.
- The settings for the archeb origin need to be adjusted accordingly, as all test programs run in its context.

No settings are needed for the arthurdent origin. It is used for unit tests.

<table>
<thead>
<tr>
<th>Origin</th>
<th>Namespace</th>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sap</td>
<td>DB</td>
<td>DBCON.TILM_STOR</td>
<td>DEFAULT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DBCON.TILM_STOR_COL</td>
<td>DEFAULT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DBCON.TILM_STOR_POOL</td>
<td>DEFAULT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DBCON.TILM_STOR_PROP</td>
<td>DEFAULT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DBCON.TILM_STOR_RTI</td>
<td>DEFAULT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DBCON.TILM_STOR_RTM</td>
<td>DEFAULT</td>
</tr>
<tr>
<td>archeb</td>
<td>DB</td>
<td>DBCON.TILM_STOR</td>
<td>DEFAULT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DBCON.TILM_STOR_AUDIT</td>
<td>DEFAULT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DBCON.TILM_BLOB</td>
<td>DEFAULT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DBCON.TILM_CERT</td>
<td>DEFAULT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DBCON.TILM_COL</td>
<td>DEFAULT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DBCON.TILM_POOL</td>
<td>DEFAULT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DBCON.TILM_PROP</td>
<td>DEFAULT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DBCON.TILM_RTI</td>
<td>DEFAULT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DBCON.TILM_RTM</td>
<td>DEFAULT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SYST.PLACES</td>
<td>ADK_FILE</td>
</tr>
</tbody>
</table>

**Note**

DEFAULT means that the local database is used. This is fine for the origin sap but for archeb origin you should use your target connection to test it properly.
3.6.3 Use Origin per System

To store your archive files you will have to create your own origin. Your first option for doing this is to implement the BAdI **ILM DB Store: Client Functions of the ILM DB Store** (**BADI_ILM_STOR_CLIENT**) separately on each system. The method **DETERMINE_STORE_ORIGIN** supplies the origin that is then sent to the ILM store.

**Note**

Note that for this to work, SRS has to be installed locally and the corresponding SRS settings must be made in transaction SARA. For more information, see the **Prerequisites** chapter in the **More Information** section of this document.

As of NetWeaver 740 SPS 13 or 7.50 SPS 02 there is a second option available. You can implement the BAdI once on the ILM Store system instead of the client systems – this allows you to have one source of truth for the origins.

3.6.4 Routing Table

The routing table supports the origin determination BAdI (**BADI_ILM_STOR_CLIENT**). It is implemented as a default implementation in class **CL_ILM_STOR_BADI_CLIENT**. The main idea is to split a resource URI into its identifying parts and to try and find a matching entry in the table. A resource URI has the following scheme:

<System>/<client_id>/<schema ID>/<object type>.

For example: The URI `YI3/000/ad/flight_bookings/aa/20150330/a005o5/a005o5-001bc_sbook.adk` can be split as follows:

- System: YI3
- Client: 000
- Scheme: ad
- Object Type: flight bookings

The routing table **TILM_STOR_O_ROUT** has an entry that matches these fields. The fields are **SYSTEM_ID, RESOURCE_TYPE, CLIENT, OBJECT_TYPE, and ORIGIN**. You can use the routing table to create any combination leading to an Origin provided the system ID is given.

<table>
<thead>
<tr>
<th>SYSTEM_ID</th>
<th>Resource Type</th>
<th>Client</th>
<th>OBJECT_TYPE</th>
<th>ORIGIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>E0C</td>
<td>A</td>
<td>000</td>
<td></td>
<td>ORIGIN_1</td>
</tr>
<tr>
<td>E0C</td>
<td>R</td>
<td></td>
<td>SFLIGHT_BOOKINGS</td>
<td>ORIGIN_3</td>
</tr>
<tr>
<td>E0C</td>
<td>R</td>
<td></td>
<td>GREAT_OBJECT</td>
<td>ORIGIN_1</td>
</tr>
<tr>
<td>E0C</td>
<td></td>
<td>100</td>
<td></td>
<td>ORIGIN_2</td>
</tr>
<tr>
<td>E0C</td>
<td></td>
<td></td>
<td></td>
<td>ORIGIN_0</td>
</tr>
</tbody>
</table>

In this example, ORIGIN_1 is used for all archive link documents from system and client combination (E0C: 000) and for all resources handling the GREAT_OBJECT. You use ORIGIN_3 for all resources from system and
client combination (E0C:000) from the SFLIGHT_BOOKINGS and ORIGIN_2 takes all objects from system and client combination (E0C:100). The fallback origin for the rest of the objects from system E0C is ORIGIN_0. The routing table can be maintained in the client systems as well as in the system that hosts the ILM Store. If you use the latter, you can skip the BAdI implementation on the client system.

3.7 Set Up Client and Origins in the ILM Store

Proceed as follows to set up the clients and origins in the ILM Store.

- Create the administrative origin and client
- Create the operational origin
- Edit origins

3.7.1 Create Clients and Origins

1. In SAP NetWeaver Customizing, choose Application Server > Basis Services > Information Lifecycle Management > ILM Store > Define Settings for Administrative Customizing.
2. Choose Create Client.
3. Enter the name of a client and then use the F4 help to choose the Logical File Name that you have already created using transaction FILE (see the chapter Making Customizing Settings using the FILE transaction in this document).
4. Specify a name and a description for the new administrative origin.
5. If needed, select the Monitoring Is Active checkbox.
6. Specify the ILM Store User if you have selected Monitoring Is Active: In this field, you can enter the name of the user for whom the request is being executed. Monitoring will use this user to query certain system statuses (such as dumps). For more information about monitoring, see the chapter on the ILM Store Monitor in this document.

   **Note**
   
   The ILM Store user corresponds to the name of the user that is used for this client as the WebDAV user.

7. In the section Administrative Origin: Table Distribution, the system displays the database connections defined for the administrative origin you have selected.
8. In the section Assigned Operational Origins: Details, you can create operational origins and make settings for database tables. Operational origins that have already been defined for the administrative origin you selected are displayed here.
9. To make adjustments, choose Add Operational Origin and enter the required data or choose Change Operational Origin.

   **Note**
   
   Note that you can only use lowercase letters for naming origins. There are no constraints concerning the selection of characters.
3.8 Table Distribution

3.8.1 Options for Table Distribution

The ILM Store requires two types of tables:

- Data tables
- Administration tables

The data tables contain the resources (for example, the ADK files).

**Note**

For performance reasons, SAP IQ locks the entire table during changing access. In a column-based database, locking a data record is one of the operations that negatively affects performance. Since archive files can become quite large, a straightforward INSERT database operation can take several minutes. This can quickly lead to a data bottleneck during parallel access. For this reason, the ILM Store generates a new table instead of granting parallel access. The new table is then included in the administration data and subsequently described. In this way a pool with data tables is formed. This procedure can be transferred to all other database systems.

These data tables are usually stored on a remote database (SAP IQ or SAP HANA). The number of tables in the pool is limited by the maximum possible number of simultaneous connections in the Internet Communication Server (ICM). As soon as the process returns to the caller, the system releases the occupied table again.

The administration tables contain the collections and properties that are directly linked to the resources. Together they make up the payload (the actual content) of Retention Management. However, because the access to properties and collections takes place more frequently and has significantly shorter access times as compared to the resources, exactly one table is used.

**Recommendation**

For performance reasons, we recommend that the collections and property tables be stored on the AS ABAP database even though they belong semantically on the same database as the resources. As a rule, the administration data is stored on the AS ABAP on which you will also find the ILM Store. This makes sense because of the access times. Above all, the initial table TILM_STOR should be stored on the AS ABAP.

**Example**

The distribution of tables shown below is a suggestion. Seen technically, the tables can be distributed as needed. This might have a strong effect on performance and should therefore be tested carefully.
Here is a list of the tables that are used and their characteristics:

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Attributes</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>TILM_STOR</td>
<td>• Frequent Access</td>
<td>AS ABAP</td>
</tr>
<tr>
<td></td>
<td>• Main table of the ILM Store, mapping from an external key to an internal key</td>
<td></td>
</tr>
<tr>
<td>TILM_STOR_RTI</td>
<td>• Very frequent access when inserting data (collections and resources)</td>
<td>AS ABAP</td>
</tr>
<tr>
<td></td>
<td>• Runtime information while inserting BLOBs into the store</td>
<td></td>
</tr>
<tr>
<td>TILM_STOR_CERT</td>
<td>• Required for each insert operation, for updating properties, in cloud scenarios for registration, and for possible REST-API operations.</td>
<td>(1) AS ABAP</td>
</tr>
<tr>
<td></td>
<td>• Can be stored on an external server for security reasons, to make access more difficult for hackers</td>
<td>(2) External DB #1</td>
</tr>
<tr>
<td></td>
<td>• Storage of certificates for signatures/QTS (if available)</td>
<td>(2) External DB #2</td>
</tr>
<tr>
<td>TILM_STOR_PROP</td>
<td>• Frequent access during queries of database properties (such as expiration_date and legal_hold), many small and often recursive queries</td>
<td>AS ABAP</td>
</tr>
<tr>
<td></td>
<td>• Properties, such as legal holds, linked with the BLOBs and collections</td>
<td></td>
</tr>
<tr>
<td>TILM_STOR_POOL</td>
<td>• Access during each write and read query of resources</td>
<td>AS ABAP</td>
</tr>
<tr>
<td></td>
<td>• Administration table for the table pool</td>
<td></td>
</tr>
<tr>
<td>TILM_STOR_COL</td>
<td>• Frequent access during queries of data properties and path (recursive) operations</td>
<td>(1) AS ABAP</td>
</tr>
<tr>
<td></td>
<td>• Collections</td>
<td>(2) External DB #1</td>
</tr>
<tr>
<td>Table Name</td>
<td>Attributes</td>
<td>Distribution</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>TILM_STOR_BLOB</td>
<td>• The cold store is required only for the physical reading and writing of resources</td>
<td>External DB #1</td>
</tr>
<tr>
<td></td>
<td>• Template table for resource pool table</td>
<td></td>
</tr>
</tbody>
</table>

⚠️ **Caution**

If you move a table from one server to another, you **must** also move the contents of that table, otherwise all of the data administration becomes invalid.

**Table distribution for certificates**

This section is intended to support you during scheduling, so that you store certificates when necessary. SAP does not support certificates at this time. However, we recommend that you take into consideration that it is best to store certificates on the AS ABAP. You can also store these on a completely separate database. Like each shift to an external database, this is accomplished only by sacrificing performance. On the other hand, the system does not constantly run checks of the signatures and timestamps, which make possible external attacks more difficult.

ℹ️ **i Note**

The current delivery does not contain the function for managing certificates. However, you should still take the underlying structure into consideration.
The following figure shows the options you have for distributing tables. AS ABAP describes the system on which the store runs; the two external databases represent the two different database connections, which are potentially two physically different database servers:

![Diagram of table distribution](image-url)
4 Publishing the ILM Store

4.1 Publish Storage System Using ICF Node

The ILM Store is addressed via the WebDAV log. For this reason, the ILM Store has to be published as a service in the ICF.

1. Start transaction SICF and skip the initial screen with the filters by choosing [F8].
2. Create a new service and enter the following values.
   - Virtual host: DEFAULT_HOST
   - Service path: Enter the service path for example, /sap/bc/ilm/zdata_vault
   - Service name: for example, ZDATA_VAULT
3. On the Handler List tab, enter a handler class (CL_ILM_STOR_WD_REQUEST_HANDLER) that serves as the request handler for the service. It represents the entry point to the functions of the ILM Store.
4. On the Logon Data tab, enter a user who has the authorization to access the ILM Store.

4.2 Create Destination in the SRS System

In the system that contains the active SRS component, you have to create a destination that points to the ILM Store.

Proceed as follows:
1. To do so, start transaction SM59.
2. Create a new HTTP connection to the external server (type G).

The path prefix that you define on the Settings tab represents the connection between the destination and the ICF node. Example: /sap/bc/ilm/zdata_example.

After you have created the destination, you can enter it in the list of stores that are available for the SRS.

Proceed as follows:
1. To do so, start transaction ILMSTOREADM.
2. Enter the following values:
   - ILM Store: An identifying name for the store
   - Description: Descriptive text
   - HTTP connection: The previously created destination

The HTTP connection can contain a URI prefix. This prefix identifies the data root to be used in the ILM Store. You must enter this URI prefix in the Customizing of the origin used by this system.
Note

In the ILM Store, the URI prefix is placed in front of the resource URI. This is why it is called prefix instead of suffix (see figure) from the perspective of transaction SM59.

Caution

When the prefix is used as shown in the figure, a file with the resource URI /sys/mandt/sflight/myflight.adk is transferred as /uri_prefix/sys/mandt/sflight/myflight.adk. This prefix must be excluded from the coding for validations and has to be specified in Customizing.

4.3 ArchiveLink Connection to the ILM Store

A new storage type has been implemented on the Content Management Server (package SCMS) to support the ArchiveLink interface in the ILM Store. In this way, CMS’s ArchiveLink interface is used.

You can use the ArchiveLink connection to the ILM Store in three different ways: as a local implementation, a remote connection, and an http server implementation serving clients on lower releases. The systems can be combined in any constellation.
In the local implementation, it is important that the CMS and the ILM Store be installed on the same system. The option of the ILM Store storing the data somewhere in the network (on the database or in the file system) is used. The goal of the local implementation is to use the transaction OAAD to store files in the context of the business object. The client, content management server, and ILM Store share the same machine. The storage media can be external.

- In remote installation, the ILM store server is installed as a separate server because it is updated more frequently than the content server. The client and the content management server are in the same machine. The ILM Store can be on a remote server.

**ArchiveLink Connection: Local Implementation**

![Diagram showing system connections]

- In remote installation, the ILM store server is installed as a separate server because it is updated more frequently than the content server. The client and the content management server are in the same machine. The ILM Store can be on a remote server.

**i Note**

The content server and the client have to be on NetWeaver 7.40 SP13 or above.
In the http server implementation, clients on lower releases that don’t have the ILM Store subtype can connect to the ILM Store through the http server. The client, content management server, and ILM Store communicate through http. The client and the content management server should have the content server storage type.

### Note
The name of the content server should be the same on the client and server.
4.3.1 Create ArchiveLink Connection

To establish an ArchiveLink connection, you perform the following steps:

1. First, check the following valid entry in the table TILM_STOR_CMS:

<table>
<thead>
<tr>
<th>Data Source</th>
<th>Namespace</th>
<th>Name of Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;origin&gt;</td>
<td>DB</td>
<td>DBCON.TILM.STOR_CMS</td>
<td>Default</td>
</tr>
</tbody>
</table>

   The default value leads to the local database of the application server.

2. Create the ILM Store-based content server.
   1. Choose Display Content Repository (transaction OAC0).
   2. Choose Change and then select the required content repository (for example, the file system or required database).
   3. Enter the values:
      - **Document area**: ArchiveLink
      - **Store type**: ILM Store (internal value: 10)
      - **Interface version**: Enter the corresponding value.
      - Choose an appropriate exchange directory.
3. If you are working in a remote scenario, enter the following values as well:
   ○ **HTTP server**: Enter the HTTP server to be used.
   ○ **Port number**: Enter the port number.
   ○ **HTTP script**: For example, `/sap/bc/ilm/zdata_vault`
   ○ **RFC destination**: Enter the RFC destination, for example, `ILM_VAULT101_yi3`

4. If you are working in a http based content server:
   To create a common http content server, perform the following steps:
   1. Create a new SICF node. For example, `zdata_vault_al` with **Documentation** as ILM Store:
      ArchiveLink Access on the system hosting the ILM Store that offers the http service.
   2. Set the handler class using the following values:
      ○ **Path**: For example, `/default_host/sap/bc/ilm`
      ○ **Service Name**: Enter the service name. For example, `zdata_vault_al`
      ○ **Description**: For example, ILM Store: ArchiveLink Access
   3. Set the handler class in the **Handler List** tab as: `CL_ILM_STOR_AL_REQUEST_HANDLER`
   4. Create a new content repository on the client system.

5. Create a new content repository in the ILM Store side. In the ILM Store, the content repository should be created so that you can check the repository and allow URL access for document retrieval.

6. Link the Content Repository with an operational origin:
   1. To do so, in SAP NetWeaver Customizing, choose **Application Server > Basis Services > Information Lifecycle Management > ILM Store > Define Settings for Administrative Customizing**.
   2. Select the required client and choose **Change**.
   3. Choose **Change Operational Origin** in the section Assigned Operational Origin: Details.
   4. Enter the name of the created Content Repository (`CREP_ID`).

7. Create the required document types. You need to add the document types that you usually use in the project for data transfer to the ILM Store using ArchiveLink. You can add different document types, such as PPTX or JPEG.
   1. Choose **Display Document Types Globally** (transaction `OAC2`) and choose **Change**.
   2. Add the document types you want to use.

For more information about ArchiveLink documentation, see SAP Help Portal at [http://help.sap.com/nw](http://help.sap.com/nw). Choose **Function-Oriented View > Application Server > Application Server ABAP > Other Services > Services for Business Users > ArchiveLink**.
7. Create the relationships for the Content Repository. To do so, you need to link the ArchiveLink object types to the relationship tables. For more information, see the ArchiveLink documentation on SAP Help Portal.

8. Test your configuration steps for the ArchiveLink connections. To do so, upload a sample document to the ILM Store and check the result.
5 Customizing

5.1 Customizing the ILM Store

5.1.1 Customizing Settings Using View TILM_STOR_CUS

In addition to the Customizing settings for the origin (see the chapters Origin and Set Up Client and Origins in the ILM Store in this document), you can use the TILM_STOR_CUS view to make other Customizing settings for the ILM Store. You can call the view by using transaction SM30.

⚠️ Caution

In this view, you can change the settings for all of the ILM Store's namespaces.

Note that when you enter the logical file names, you should use only the settings for the namespace SYST.PLACES.

If you want to make additional settings for other namespaces, do so only after consulting SAP. Changes could lead to a loss of data. Use component BC-ILM-STO to contact SAP Support for questions about the settings regarding namespaces other than SYST.PLACES.
The figure shows the origins used internally for the test environment with sample settings.

**SYSTEM Namespace: System Settings**

This namespace contains all of the settings that control general processing.

**Property: FILE_SINK_SIZE**

When data is transferred to the store, the store first buffers it before the information that the data is now complete and can be added to the database is issued. This means it is possible, for example, to transfer the data in multiple small requests instead of in one large request, which significantly improves the error tolerance. The main memory is usually used as the buffer. If the server does not have a lot of main memory or if there is too much data to be stored, a temporary file can be used as the buffer. This value defines the data size as of which a temporary file is to be used. This is where you enter the value, in megabytes, up to which files can be stored in the main memory.

FILE_SINK_SIZE defines the maximum size (in MB) of a data block sent by a PUT request up to which data can be processed simultaneously. As of this size, data is stored in a temporary file (ILM_STOR_FILE in the ILM_STOR_FOLDER directory) and processed asynchronously. If you use the value -1, this always means that the data buffer is also used.
Properties: SAP_ILM_AL_CONFORMANCE and SAP_ILM_CONFORMANCE

These are used for internal settings and define the return value for a corresponding OPTIONS request.

**Property: STREAMING_SIZE**

You can use two different methods to write resources to the database:

- As a host variable with an INSERT instruction
- In a streaming procedure, as you would for a file

The theoretical threshold of two gigabytes is set for the host variable; in actual fact, this threshold is reached much earlier. However, the procedure is faster than the streaming procedure. You specify the amount of data up to which the system uses a host variable by using the `Streaming Size` value. This is where you enter the value, in megabytes, up to which files can be transferred with SQL and a host variable.

`STREAMING_SIZE` defines the size of the data blocks transferred using PUT as of which the data is written to the database with the streaming API instead of with the “normal” SQL.

⚠️ **Caution**

Theoretically, the streaming procedure can process any amount of data, however, it requires substantially more runtime and is not available on all platforms. Therefore, use this procedure only after consulting SAP. We recommend that you do not use this procedure.

**Properties: ADK_DB_SIZE and DATA_DB_SIZE**

It is possible to store mixed data in the database as well as in the file system. This is primarily for scenarios in which the ILM Database Store is used as a random store: This means you can store CD images anywhere in the file system whereas relevant business data is written to the database (as it has been up to now). ADK stands for files in the ILM context. For all other data, use DATA.

**Properties: LEAVE_RESSOURCES_IN_QUEUE and LEAVE_RESSOURCES_IN_QUEUE_AN**

This flag is available should there already be a constellation in which a customer-specific job control system takes on the distribution of data from PUT requests. If the flag is set, the data stays in the queue and the job control system must shift it to its final destination. You use AN for all non ADK files.

**Property: MAX_PUT_JOBS**

This property defines the maximum number of jobs that can be used for each application server in background processing of the PUT requests of the ILM Database Store.

**Property: SAP_ILM_SHARED_FILE**

You use this property for internal settings and to define the return value of a corresponding OPTIONS request.

**Property: STORE_DB_THRESHOLD**

This property is obsolete and has been replaced by `ADK_DB_SIZE` and `DATA_DB_SIZE`.

---

**DB Namespace: Settings Relating to the Database**

This namespace bundles all of the settings that refer to database access. The central values are the `DBCON.TILM_STOR*` entries: They contain the access to the connection to be used on the individual tables. Enter the relevant table distribution.
Property: TABLE_THRESHOLD

Resources are stored in data tables. New tables are generated as soon as parallel access to a data table is required. Tables can be taken from the resulting pool as needed. This happens until there are no more free tables and new tables have to be generated.

In time this would lead to tables taking on large amounts of data. With the help of the threshold value, you can make settings that specify as of which table size you can no longer get tables from the pool. The value to be entered identifies the threshold value in gigabytes up to which a table can be described. If you exceed this value, the affected table changes to read-only mode from the store’s perspective.

Property: DBCON.<table name>

You use this property for the database connection to the relevant table <table name>. DEFAULT means that this table is used on the current application server. This is a valid setting for all tables except DBCON.TILM_STOR_BLOB. As this is an administration table, performance is an important factor when accessing it. Table DBCON.TILM_STOR_BLOB, on the other hand, contains the data that will actually be stored.

Diagnostics Namespace: Analysis and Monitoring Settings

This namespace groups all of the settings that refer to diagnostic information. Both error analysis and the monitoring functions are controlled here.

Property: DEBUG

This property makes it possible to write messages marked with DEBUG to the application log. We recommend using this property only in test mode.

Property: TRACE

This property makes it possible to write messages marked with TRACE to the application log. We recommend using this property only in test mode.

Property: EMAIL_DIAG_NOTIFY

Currently, you cannot use this property.

Property: EVENTS

Switches on eventing, which is used for monitoring as well as for audit data.

Property: SILENT

If this property is activated, only error messages and warnings are written to the application log.

Property: TH_PUT_IN_PROCESS

This property defines the maximum number of temporary files resulting from a PUT request that can be stored in the queue. If this value is exceeded, a comment is made in the application log.
SYST.PLACES Namespace: Settings for the File System and Other Locations

This namespace contains the settings that refer to the storage location, such as the file system or other storage locations.

5.1.2 Making Customizing Settings with Transaction FILE

All of the values named here represent path and file name pairs. You can make the settings for these pairs using the FILE transaction.

ADK_FILE and ADK_ROOT_FOLDER

Define the logical file name (path and file name) of ADK files if these are to be stored in the file system. (ADK files are files stored in the ILM context).

AN_FILE and AN_ROOT_FOLDER

Define the logical file name (path and file name) of anonymous files if these are to be stored in the file system. Anonymous files are those that are stored outside of the ILM context.

ILM_STOR_FILE and ILM_STOR_FOLDER

Define the logical file name (path and file name) of temporary files, for example, those used when buffering PUT requests.

ILM_STOR_REQ_SHARED_FILE and ILM_STOR_REQ_SHARED_FOLDER

Define the logical file name (path and file name) in the situation where the ADK transports the PUT request data using a shared file instead of in the HTTP request. Normally, this is the logical file name under which the ADK files are stored (ARCHIVE_GLOBAL_PATH).
5.1.3 Overview: Namespaces and Properties

Below you will find a list of the current namespaces and properties and as of which release they are available:

<table>
<thead>
<tr>
<th>Namespace</th>
<th>Property</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB</td>
<td>DBCON.TILM_STOR</td>
<td>&lt;No Default&gt;</td>
</tr>
<tr>
<td></td>
<td>DBCON.TILM_STOR_BLOB</td>
<td>&lt;No Default&gt;</td>
</tr>
<tr>
<td></td>
<td>DBCON.TILM_STOR_CERT</td>
<td>&lt;No Default&gt;</td>
</tr>
<tr>
<td></td>
<td>DBCON.TILM_STOR_COL</td>
<td>&lt;No Default&gt;</td>
</tr>
<tr>
<td></td>
<td>DBCON.TILM_STOR_POOL</td>
<td>&lt;No Default&gt;</td>
</tr>
<tr>
<td></td>
<td>DBCON.TILM_STOR_PROP</td>
<td>&lt;No Default&gt;</td>
</tr>
<tr>
<td></td>
<td>DBCON.TILM_STOR_RTI</td>
<td>&lt;No Default&gt;</td>
</tr>
<tr>
<td></td>
<td>DBCON.TILM_STOR_AUDIT</td>
<td>&lt;No Default&gt;</td>
</tr>
<tr>
<td></td>
<td>DBCON.TILM_STOR_RTM</td>
<td>&lt;No Default&gt;</td>
</tr>
<tr>
<td>DIAGNOSTICS</td>
<td>DEBUG</td>
<td>&lt;space&gt;</td>
</tr>
<tr>
<td></td>
<td>TRACE</td>
<td>&lt;space&gt;</td>
</tr>
<tr>
<td></td>
<td>EMAIL_DIAG_NOTIFY</td>
<td>&lt;space&gt;</td>
</tr>
<tr>
<td></td>
<td>EVENTS</td>
<td>&lt;space&gt;</td>
</tr>
<tr>
<td></td>
<td>SILENT</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>TH_PUT_IN_PROCESS</td>
<td>50</td>
</tr>
<tr>
<td>SYSTEM</td>
<td>FILE_SINK_SIZE</td>
<td>300</td>
</tr>
<tr>
<td></td>
<td>SAP_ILM_AL_CONFORMANCE</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>SAP_ILM_CONFORMANCE</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>STREAMING_SIZE</td>
<td>900 (MB)</td>
</tr>
<tr>
<td></td>
<td>ADK_DB_SIZE</td>
<td>-1</td>
</tr>
<tr>
<td></td>
<td>DATA_DB_SIZE</td>
<td>-1</td>
</tr>
<tr>
<td></td>
<td>LEAVE_RESSOURCES_IN_QUEUE</td>
<td>&lt;space&gt;</td>
</tr>
<tr>
<td></td>
<td>LEAVE_RESSOURCES_IN_QUEUE_AN</td>
<td>&lt;space&gt;</td>
</tr>
</tbody>
</table>
5.2 Scenarios for Settings

Below, you will find descriptions of setting combinations that define known scenarios. If none of the scenarios mentioned above fit your system environment, use component BC-ILM-STO to contact SAP Support.

5.2.1 Use Shared Files as a Transport Medium

You can transport data that is intended for storage in so-called Shared Files.

1. To do so, the ILM Database Store must be able to access the directory used by ADK so that the file(s) can be saved before they are stored.
2. You must enter the directory in Customizing under the ILM_STOR_REQ_SHARED_FOLDER key.
3. Set the value for SAP_ILM_SHARED_FILE to a value that is not 0 so that the ADK knows that the data can be sent in this way.

5.2.2 Buffering PUT Request in a File

This setting makes scenarios possible in which data is transferred to the ILM Database Store in multiple steps. The numeric value is interpreted as MB. The default setting is 300 MB. In the system, check what the best value is. The following aspects should be taken into account:

<table>
<thead>
<tr>
<th>Namespace</th>
<th>Property</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MAX_PUT_JOBS</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>SAP_ILM_SHARED_FILE</td>
<td>0</td>
</tr>
<tr>
<td>SYST.PLACES</td>
<td>ADK_FILE</td>
<td>ILM_STOR_ADK_FILE</td>
</tr>
<tr>
<td></td>
<td>ADK_ROOT_FOLDER</td>
<td>ILM_STOR_ADK_ROOT_FOLDER_A_FILE</td>
</tr>
<tr>
<td></td>
<td>AN_ROOT_FOLDER</td>
<td>ILM_STOR_AN_ROOT_FOLDER</td>
</tr>
<tr>
<td></td>
<td>ILM_STOR_FILE</td>
<td>ILM_STOR_FILE</td>
</tr>
<tr>
<td></td>
<td>ILM_STOR_FOLDER</td>
<td>ILM_STOR_FOLDER</td>
</tr>
<tr>
<td></td>
<td>ILM_STOR_REQ_SHARED_FILE</td>
<td>ILM_STOR_REQ_SHARED_FILE</td>
</tr>
<tr>
<td></td>
<td>ILM_STOR_REQ_SHARED_FOLDER</td>
<td>ILM_STOR_REQ_SHARED_FOLDER</td>
</tr>
</tbody>
</table>
The overload caused by the file system is much bigger for larger amounts of data than for small amounts of data.

In addition, you need to take the complete process into consideration: The synchronous access to the database can quickly lead to a bottleneck if you use remote SQL.

- Always buffer PUT requests: \texttt{FILE\_SINK\_SIZE} = -1
- Buffer PUT requests only as of a specific size: \texttt{FILE\_SINK\_SIZE} = [xxx] MB

### 5.2.3 Using the File System as a Store

You can use a file system to store your files. To do so, you need the following information:

- The value is queried in a BAdi implementation (enhancement spot \texttt{ENHS\_ILM\_STOR\_PROCESS})
- The system differentiates between ADK files (\texttt{ADK\_DB\_SIZE}) and other (non ADK) files (\texttt{DATA\_DB\_SIZE})
- The value is specified in kilobytes (100000 ≈ 100 kB)

Note the following settings:

- Always store this data in the file system: \[\texttt{[ADK|DATA]}\_{DB\_SIZE} = 0\]
- Store this data in the file system as of a specific size: \[\texttt{[ADK|DATA]}\_{DB\_SIZE} = \text{Size in bytes up to which data should be written to the database}\]
- Larger data is moved to the file system.

- Always write this data to the database: \[\texttt{[ADK|DATA]}\_{DB\_SIZE} = -1\]

### 5.2.4 Use the External Job Control System

If you want to use an external job control system, note the following information:

- PUT requests must be buffered in the file system
- The system differentiates between ADK files (\texttt{ADK\_DB\_SIZE}) and other (non ADK) files (\texttt{DATA\_DB\_SIZE})

Also note the following settings:

- \[\texttt{[ADK|DATA]}\_{DB\_SIZE} = 0\]
- \[\texttt{[AN]}\_LEAVE\_RESSOURCES\_IN\_QUEUE = X\]
6 Analysis Tools and Tests

6.1 Permitting Multiple User Agents

One of the ways to identify the HTTP connection is with the help of a user agent. For Storage Retention Service (SRS) this is SAP XML DAS. If you want to access the ILM Database Store with another WebDAV client, such as the DAV explorer, the attempt will fail. You will receive a message saying the user agent is unknown.

To make a user agent known, you can implement BAdI BADI_ILM_STOR_PROCESS. The method IS_VALID_USER_AGENT checks whether a character strings identifies a permitted user agent.

6.2 Audit Table TILM_STOR_AUDIT

The audit table TILM_STOR_AUDIT writes specific basic data:

- Which queries are moved to the store
- For each request, there is a note that states where it came from
- The time at which the request was received
- The duration of the processing time
- The amount of data was processed (if a data block was processed)
- The return code with which processing was completed

You can use this table to perform simple evaluations with the help of transaction SQVI or another table calculation program.

6.3 Test Environment

The following test reports are available for testing different ILM Store scenarios:

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>RILM_STOR_TEST_AT</td>
<td>Checks whether ILM Store works correctly.</td>
</tr>
<tr>
<td>RILM_STOR_TEST_PF_SINGLE</td>
<td>Measures the processing time of each data block</td>
</tr>
<tr>
<td>RILM_STOR_TEST_PF_REPEAT_SMALL</td>
<td>Performance test: Multiple runs with small data blocks</td>
</tr>
<tr>
<td>RILM_STOR_TEST_PF_REPEAT_BIG</td>
<td>Performance test: Multiple runs with large data blocks</td>
</tr>
<tr>
<td>Report Name</td>
<td>Purpose</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RILM_STOR_TEST_CLEAR</td>
<td>Deletes the test report data</td>
</tr>
<tr>
<td>RILM_STOR_WD_DEMO</td>
<td>Console for testing individual commands and command sequences</td>
</tr>
<tr>
<td>RILM_STOR_TEST_EMAIL_CHECK</td>
<td>Email Notification Utility Check Report. This report checks if the email sending functionality for ILM Store is enabled.</td>
</tr>
<tr>
<td>RILM_STOR_TEST_PET</td>
<td>Performance Evaluation Tool. This report checks the performance measurement of ILM Store’s operations.</td>
</tr>
<tr>
<td>RILM_STOR_TEST_HC_SERVER</td>
<td>Health Check for Server. This report checks the ILM Store’s configuration.</td>
</tr>
<tr>
<td>RILM_STOR_TEST_HC_CLIENT</td>
<td>Health Check for Client. This report checks the Archiving client’s configuration.</td>
</tr>
<tr>
<td>RILM_STOR_TEST_ROUTING</td>
<td>This report fills the table TILM_STOR_O_ROUT with test data. It can also remove the test data and can test two operations: LIST and DETERMINE_ORIGIN.</td>
</tr>
</tbody>
</table>

### 6.3.1 Origin for Test Purposes

SAP delivers two Origin values for test purposes:

- **arthurdent**
  - You use this Origin exclusively for unit tests. The origin is dealt with explicitly in the coding.
- **archeb**
  - You use this Origin to test the ILM Store physically.

### 6.3.2 Acceptance Test

You use report **RILM_STOR_TEST_AT** to check various data constellations and operations as defined in the specification BC-ILM 3.0 and which a store must fulfill.

1. Start transaction **SE38**.
2. Run report **RILM_STOR_TEST_AT**.
3. Enter the destination to be checked.
4. Choose **Execute**.

The tests issues a log as a summary. The log shows the failed as well as the successful processes of the run.
6.3.3 Delete Test Data

You use the delete report to delete the data created by the test report.

1. Start transaction SE38 and execute report RILM_STOR_TEST_CLEAR.
2. In the report, select the specification: Origin for complete tests.

Note

A further run of the test report as part of the acceptance test returns only green traffic lights. The installation and configuration of the ILM Store is complete.

6.3.4 Performance Test

The performance tests are available in several versions:

- Multiple transfer of small files
- Multiple transfer of large files
- Individual test for files of any size

Test of sequences

Two reports are available. The only difference between them is that you can process different amounts of data.

- RILM_STOR_TEST_PF_REPEAT_SMALL (processes data blocks of 100 or 500 kilobytes or 1 megabyte)
- RILM_STOR_TEST_PF_REPEAT_BIG (processes data blocks of 100, 250, and 500 kilobytes)

Follow the procedure below:

1. Start transaction SE38 and run one of the reports.
2. Select the size of the BLOB with which you want to run the tests.
3. Specify how often you want to repeat the write access with the selected size.
The following figures shows the report issued in its simplest form:

![SAP ILM Storage - Performance Test Loop](image)

**Log for Test of Sequences**

**BLOB Size:** 100 KB w. 100 Retries, **Started At:** 2013-11-12T14:51:45Z  
**Destination:** ILM_VAULIT101_Y13

**HEAD 200 OK**  
**OPTIONS 200 OK**

- OPTIONS -> DAV = 1,2  
- OPTIONS -> ILM_CONFORMANCE = 2  
- OPTIONS -> ILM_AL_CONFORMANCE = 2  

001) MKCOL 201 Created  
     /sap  
002) MKCOL 201 Created  
     /sap/test  
003) MKCOL 201 Created  
     /sap/test/perf  
004) MKCOL 201 Created  
     /sap/test/perf/repeat100  
005) PUT 201 Created  
     /sap/test/perf/repeat100/res1.bin  
006) PUT 201 Created  
     /sap/test/perf/repeat100/res2.bin

**BLOB Size:** 100 KB w. 100 Retries **Completed At:** 2013-11-12T14:54:45Z  
**Creation of Collections Required:** 4 **Seconds**  
**Storing Resource(s) Required:** 150 **Seconds**  
**Deleting Collection(s) Required:** 25 **Seconds**

---

**Individual Tests**

For example, you can use report RILM_STOR_TEST_PF_SINGLE to test the processing of an individual data block for trace purposes.

1. Start transaction SE38 and execute the report.  
2. Select the size of the BLOB that you want to use for testing.

**Note**

You have to specify the resource counter in the report only if you want to start multiple runs in sequence. This forms the resource name that is stored and which must be unique.

The following figure shows a report for a successful individual test.
Log for Individual Tests

SAP ILM Storage - Simple Performance Test

SAP ILM Storage - Simple Performance Test: 109 MB, Started At 2013-11-12T15:24:33Z
Destination ILM_VAULT:01_Y73

HOLD 200 GB
OPTIONS 2000 KB

OPTIONS -> DAV -1,2

OPTIONS -> ILM CONFIGURATION -2

OPTIONS -> ILM ALL CONFIGURATION -2

001). MMCDL 405 Method not allowed
/sap
=> Errors

002). MMCDL 405 Method not allowed
/sap/test
=> Errors

003). MMCDL 201 Created
/sap/test/pr12

004). MMCDL 201 Created
/sap/test/pr12/single

005). PUT 201 Created
/sap/test/pr12/single/res_01.bin
154974 Bytes

006). GET 200 OK
/sap/test/pr12/single/res_01.bin

007). DELETE 200 Multi status
/sap
=> Errors

008). PROPPING PUT Multi status
=> Errors

SAP ILM Storage - Simple Performance Test: 109 MB Completed With 4 Error(s) At 2013-11-12T15:27:15Z

Creation of Collections Required 11 Seconds
Storing Resource Required 3 Seconds
Reading Resource Required 10 Seconds
Deleting Collection(s) Required 3 Seconds
7  Console

You use report RILM_STOR_WD_DEMO to send the basic commands for the WebDAV log to the store, either as single commands or as a command chain with a test queue.

1. Start transaction SE38 and execute the report.
2. Enter the resource URI that you want to edit. Enter the destination that is related to the store as well as the source ID (Origin) to be used.

   **Note**
   
   SAP supports only the Active Origin in the current version. Entries for the source ID are not taken into consideration at this time.

3. Now you can select the command you want to send. Depending on the command, you may need to enter additional parameters. The command can be executed immediately or attached to the current chain of commands (test queue).

The following figure shows a typical call sequences:

![Example of a call sequence](image)

The following figure shows an excerpt of the event log for the call as it is displayed in the log window.
Example of a log

HEAD command [1293mili-second]:
Response header:
~response_line: HTTP/1.0 404 Not found
~server_protocol: HTTP/1.0
~status_code: 404
~status_reason: Not found
set-cookie: sap-usercontext=sap-language=E; path=/
set-cookie: SAP_SESSIONID_YI3_000=rt5n2c71xmexoygt22jml9g_RltBiijaAUAUFaAZU%3d; path=/; HttpOnly
content-type: application/octet-stream
content-length: 34
service_message: See message body
Status code:404 -Not found

OPTIONS command [4643mili-second]:
Response header:
~response_line: HTTP/1.0 200 OK
~server_protocol: HTTP/1.0
~status_code: 200
~status_reason: OK
set-cookie: sap-usercontext=sap-language=E; path=/
set-cookie: SAP_SESSIONID_YI3_000=UebWi1hCCoRjhNlb-BZG13AJic2LtBBHijaAUAUFaAZU%3d; path=/; HttpOnly
content-type: text/html
content-length: 0
dsv: 1,2
sap-im-conformance: 2
sap-im-al-conformance: 2
ilm-stor-wd-uri_alias_support: 0
ilm-stor-wd-default_range_unit: B
ilm-stor-wd-set_and_remove_tag_in_one_request_support: 0
Status code:200 -OK

MKCOL command [1267mili-second]:
Response header:
~response_line: HTTP/1.0 201 Created
~server_protocol: HTTP/1.0
~status_code: 201
~status_reason: Created
set-cookie: sap-usercontext=sap-language=E; path=/
set-cookie: SAP_SESSIONID_YI3_000=n2pScbc5CO7WymwsmvQ9nDGuSltBBHijaAUAUFaAZU%3d; path=/; HttpOnly
content-type: text/html
content-length: 0
Status code:201 -Created
Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.

About the icons:

- Links with the icon 🔗: You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your agreements with SAP) to this:
  - The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
  - SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any damages caused by the use of such content unless damages have been caused by SAP’s gross negligence or willful misconduct.

- Links with the icon 🌐: You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this information.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your feedback (e.g., in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of example code unless damages have been caused by SAP’s gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.